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Classroom Performance System 
CPS AUTHORING  
 
Introduction 
CPS gives you the ability to construct course relevant questions. CPS also provides you with the ability to track each 
student's performance data generated during delivery sessions, and to subsequently produce student and class 
performance reports with respect to your course lesson.  
 
Summary 
In this section you will find information and instructions about: 
 
•  Creating databases 
•  Creating objectives 
•  Creating lessons 
•  Creating rosters 
•  Creating challenge boards 
 
CREATING DATABASES 
A database is a collection of information (data) that is organized in such a way as to make it easy to retrieve and 
use. The CPS databases hold lessons, rosters, challenge boards, delivery session results and student performance 
data.  
 
Start the CPS Software  
1. Click the Start menu in your Windows taskbar. 
2. Click the Programs folder. 
3. Find the CPS icon and click that. 
 
! NOTE: Each time you start CPS, the software automatically looks for and opens the database you had 
open when you quit CPS previously. If CPS cannot find that database (it has been moved or renamed), a dialog box 
will prompt you to Open a database or create a New database. If you get this dialog box click New to start a new 
database, or click Open to search for and open a previously created database. Refer to Creating a New Database or 
Opening an Existing Database for instructions. 
 
4. This starts CPS. You will see an interface similar to the following image. 
 

 
Empty CPS Lessons Tab 
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Databases: Create New or Open Pre-existing  
Creating a New Database 
1. Start the CPS software. 
2. Click File from the menu bar. 
3. Click New Database. 
4. A New CPS Database dialog box appears.  
5. Type the database file name that you are creating in the File Name text box. The file extension .cps is 

automatically added to your file name. The database is saved in the CPS folder. For example, if you teach 3 
sections of Math, then you might name one database Math1.cps. 

6. Click Save.  
7. Wait while CPS processes your request. 
8. An empty Lesson tab is displayed with your database name in the title bar of that window. 
9. Repeat steps 1-6 for as many databases as you need to help you keep course and class lessons organized. 
 
The database you created using the preceding steps is automatically opened. If you were to quit the CPS software 
now, the next time you start the software this database will open automatically. 
 
Opening an Existing Database 
If the .cps file that you had opened the last time you used CPS is available, then that file will be opened 
automatically. But if the last .cps file that you had opened is no longer available (due to renaming, deleting or 
moving) then you will have to create a new .cps file now or open a different, pre-existing .cps file 
 
1. Start the CPS software. 
2. Click File from the menu bar. 
3. Click Open Database. 
4. An Open CPS Database dialog box appears.  
5. Select the database you want to activate.  
! NOTE: Remember, the CPS Content folder contains multiple databases full of questions. 
 
6. Click Open.  
7. Any lessons that are in this database are displayed on the Lessons tab. 
 
The File menu item lists the last 10 database (.cps) files you had opened in CPS. This allows you to go to the File 
menu item and select a previously opened database as opposed to going through the steps from the Open Database 
command. 
 
CREATING OBJECTIVES 
CPS Objectives are course/lesson goals that can be associated with individual questions. Add objectives now and 
refer to them throughout the year for benchmark measurements of progress. In time, CPS will also allow you to 
generate performance reports based on objectives, so you can see what goals still need to be met or have been 
achieved. You have the following options from the Objectives tab: 
•  New objectives 
•  Subcategories for objectives 
•  Edit objectives 
•  Delete objectives 
 
New Objectives 
1. Start the CPS software. 
2. Click the Objectives tab. 
3. Click the New button. 
4. The Objective Author dialog box opens. 
 

 
Objective Author Dialog Box 
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5. Type in the title/name of an objective and a description (optional) of that objective. For example, an objective 

could be Long Division, while the description would explain how knowing long division is used to build up 
other, more advanced math skills. 

6. Click the OK button to continue or Cancel to delete this objective. 
7. The objective is added to the Objectives tab. 
8. Repeat steps 3-6 for as many objectives as you want to add to this database. 
 
Objectives Subcategories 
If you have existing objectives in a database, you can add subcategories to each objective, for more detailed 
direction of a course goal. 
1. Start the CPS software. 
2. Click the Objectives tab. A list of objectives appears onscreen.  
3. Select an objective from the list. 
4. Click the New Sub button. 
5. The Objective Author dialog box opens. 
6. Type in the title/name of a subcategory and a description (optional) of that. For example, an objective could be 

Long Division, and the subcategory could be long division with fractions.  
7. Click the OK button to continue or Cancel to delete this subcategory. 
8. The subcategory is added beneath the objective you selected in step 3. A hierarchy of + icons is displayed to 

identify objectives with subcategories. Click the + to see the subs. 
9. Repeat steps 3-7 for as many subcategories as you want add to this database. 
 
Edit Objectives 
1. Start the CPS software. 
2. Click the Objectives tab. A list of objectives and subcategories appears onscreen.  
3. Select an objective or subcategory from the list. 
4. Click the Edit button. 
5. The Objective Author dialog box opens. 
6. Alter the objective or subcategory title/name and/or description. 
7. When you are finished, click the OK button or Cancel to delete this request. 
8. Repeats steps 3-7 for each objective and/or subcategory you want to edit. 
 
Delete Objectives 
The Objectives feature has a built in safety measure to prevent valuable objectives from being deleted mistakenly. In 
order to delete any main objective heading, you must first permanently delete any sub-categories that objective may 
have. 
 
Also, once an objective is associated with a question, then you cannot delete that objective until the question 
association is eliminated. Refer to Edit Questions in an Existing Lesson for instructions on how to do that. 
 
1. Start the CPS software. 
2. Click the Objectives tab. A list of objectives and subcategories appears onscreen.  
3. Select an objective or subcategory from the list. 
4. Click the Delete button. 
5. An onscreen message asks you to confirm your delete request.  
6. Click OK or Cancel. 
7. Repeat steps 3-6 for as many objectives or subcategories you want to delete. 
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CREATING LESSONS 
Lessons Overview  
CPS allows you to construct a course-specific, interactive lesson of questions. Using the CPS software, you can 
integrate your own questions and graphics into a powerful database that supports the instructional activities of all 
your courses. All lesson authoring steps are performed from the Lessons tab, shown here empty. 
 

 
Empty CPS Lessons Tab 

 
The following functions can be performed from the Lessons tab: 
 
•  Create new lessons 
•  Add questions to a lesson 
•  Lesson builder  
•  Import lessons 
•  Edit lessons 
•  Delete lessons  
•  Print lessons for exams 
•  Develop a quick answer key to coordinate with paper tests 
•  Deliver lessons without recording performance data (Preview) 
•  Deliver lessons to record performance data (Engage) 
•  Exit CPS 
 
The lessons created by CPS are easy to deliver to your class and the performance data can be saved to the database 
when used with the CPS response system. These responses are considered performance data and can be used for 
immediate feedback or for later evaluation purposes. Students simply respond to questions using the response pads. 
Answers are recorded by the response system and attributed to each student or team according to the roster 
associated with the lesson you are delivering to your class. 
 
 
Start the CPS Software  
1. Click the Start menu in your Windows taskbar. 
2. Click the Programs folder. 
3. Find the CPS icon and click that. 
 
! NOTE: Each time you start CPS, the software automatically looks for and opens the database you had 
open when you quit CPS previously. If CPS cannot find that database (it has been moved or renamed), a dialog box 
will prompt you to Open a database or create a New database. If you get this dialog box click New to start a new 
database, or click Open to search for and open a previously created database. Refer to Creating a New Database or 
Opening an Existing Database for instructions. 
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4. This starts CPS. You will see an interface similar to this one. 
 
 

 
The CPS Interface Displaying a Database with Lessons of Questions 

 
 
Create a New Lesson  
1. Start CPS. 
2. Any lesson you create is saved in a database. Open an existing database now or create a new database using the 

instructions in Databases: Create A New One Or Open A Pre-existing One. 
3. Click the Lessons tab. 
4. Click the New button on the Lessons tab. 
5. The Lesson Attributes window pops up. 
6. Type in the title of the lesson (for example, Chapter 1 or Adjectives). 
7. Type in a description of the lesson (for example, which class section this lesson is for, the teaching goals of this 

chapter, etc.). 
8. Click the OK button to save your new lesson information. Or click the Cancel button to return to the Lesson tab 

without saving any data. 
 
The lesson title is saved in the database and is displayed on the Lesson tab. Multiple lesson names can be reordered 
by clicking on a lesson name, dragging that lesson name to a new position in the list, and then releasing the mouse to 
drop that lesson into its new spot. 
 
 
Add Questions to Lessons 
1. Start CPS. 
2. Open the database that contains the lesson you want to add questions to, if it is not already open. 
3. Click the Lessons tab. 
4. The lessons you opened are listed on the Lessons tab. 
5. Select the lesson you want to add questions to. 



6 CPS Instructional Guide 

6. Click the Edit button. 
7. The Lesson Name window opens. 
 

 
The Lesson Name Window with No Questions 

 
8. In this window, click the New button. 
9. The Question Authoring window appears. This is where you will choose your question template, type your 

question and answer choices (if applicable), decide if the question is subjective, decide difficulty level of 
question, and make any font changes.  

 
Please review the following sections of information for question authoring instructions. When you have reviewed the 
instructions about creating questions go to Add Questions to Lessons (cont.’d) and begin at step 10. 
 
! NOTE: Notice that the title in the Question Authoring window displays the numerical position of the 
question you are adding.  
 

 
Question Authoring Window 

 
Question Authoring Functions 
On the question-authoring page you can perform the following functions: 
•  Select a question template specific to your question/answer needs 
•  Choose to show graphics with or after a question 
•  Make a question subjective 
•  Alter the question difficulty level  
•  Format the font style of questions/answers 
•  Character map 
•  Associate course objectives with questions 
•  Add notes to a question  
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Question Templates 
Since you are creating the questions your students will see in the lesson, you can determine the type of question and 
many other question attributes. Below are the 30 question templates and the graphic placement options that are 
available. 
 
•  MC2, Answer Graphics: This is a multiple choice question with 2 answer choices (A-B) and no graphics 

included with the question text but with a graphic included for each of the answer choices. 
•  MC2, Big Question Graphic: This is a multiple-choice question with 2 answer choices (A-B) where a large 

graphic can be included with the question text but not in the answer choices. 
•  MC2, No Graphics: This is a multiple-choice question with 2 answer choices (A-B) and no graphics included 

in the question text or the answer choices. 
•  MC2, Question Graphic: This is a multiple-choice question with 2 answer choices (A-B) and a graphic 

included with the question text but not in the answer choices. 
•  MC2, Question Graphic, Answer Graphic: This is a multiple choice question with 2 answer choices (A and 

B) and a graphic included with the question text and with each of the answer choices. 
•  MC3, Answer Graphics: This is a multiple choice question with 3 answer choices (A-C) and no graphics 

included with the question text but with a graphic included for each of the answer choices. 
•  MC3, Answer Graphics II: This is a multiple choice question with 3 answer choices (A-C) and no graphics 

included with the question text but with ONLY graphics included for each of the answer choices. There is NO 
text allowed for any answer choice. 

•  MC3, No Graphics: This is a multiple-choice question with 3 answer choices (A-C) and no graphics included 
in the question text or the answer choices. 

•  MC3, Question Graphic: This is a multiple-choice question with 3 answer choices (A-C) and a graphic 
included with the question text but not in the answer choices. 

•  MC3, Question Graphic, Answer Graphic: This is a multiple choice question with 3 answer choices (A-C) 
and a graphic included with the question text and with each of the answer choices. 

•  MC4, Answer Graphics: This is a multiple choice question with 4 answer choices (A-D) and no graphics 
included with the question text but with a graphic included for each of the answer choices. 

•  MC4, Big Question Graphic: This is a multiple-choice question with 4 answer choices (A-D) where a large 
graphic can be included with the question text but not in the answer choices. 

•  MC4, No Graphics: This is a multiple-choice question with 4 answer choices (A-D) and no graphics included 
in the question text or the answer choices. 

•  MC4, No Graphics, Big Question: This is a multiple-choice question with 4 answer choices (A-D) and no 
graphics included in the question text or the answer choices. It is ideal for essay questions or other question 
types with extensive text. 

•  MC4, Question Graphic: This is a multiple choice question with 4 answer choices (A-D) and a graphic 
included with the question text but not in the answer choices. 

•  MC4, Question Graphic Bottom: This is a multiple choice question with 4 answer choices (A-D) and a 
graphic included with the question text but not in the answer choices. The image is placed directly beneath the 
question text. 

•  MC4, Question Graphic Right: This is a multiple choice question with 4 answer choices (A-D) and a graphic 
included with the question text but not in the answer choices. The image is placed to the right of the question 
text. 

•  MC4, Question Graphic, Answer Graphics: This is a multiple choice question with 4 answer choices (A-D) 
and a graphic included with the question text and with each of the answer choices. 

•  MC4, Question Graphic Right, Big: This is a multiple choice question with 4 answer choices (A-D) and a 
graphic included with the question text but not in the answer choices. The image is placed to the right of the 
question text and can be unusually large if you need it to be. 

•  MC5, Answer Graphics: This is a multiple choice question with 5 answer choices (A-E) and no graphics 
included with the question text but with a graphic included for each of the answer choices. 

•  MC5, No Graphics: This is a multiple-choice question with 5 answer choices (A-E) and no graphics included 
with the question text or the answer choices. 
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•  MC5, No Graphics, Big Question: This is a multiple-choice question with 5 answer choices (A-E) and no 
graphics included in the question text or the answer choices. It is ideal for essay questions or other question 
types with extensive text. 

•  MC5, Question Graphic Mid: This is a multiple choice question with 5 answer choices (A-E) and a graphic 
included with the question text but not in the answer choices. The image is placed between the question and the 
answer choices. 

•  MC5, Question Graphic Right: This is a multiple choice question with 5 answer choices (A-E) and a graphic 
included with the question text but not in the answer choices. The image is placed to the right of the question 
text, and can be a large-scale image. 

•  MC5, Question Graphic Right, Small: This is a multiple choice question with 5 answer choices (A-E) and a 
graphic included with the question text but not in the answer choices. The image is placed to the right of the 
question text. 

•  MC5, Question Graphic Right, Big: This is a multiple choice question with 5 answer choices (A-E) and a 
graphic included with the question text but not in the answer choices. The image is placed to the right of the 
question text and can be unusually large if you need it to be. 

•  T/F, No Graphics: This is a true/false question and no graphics included in the question text or the answer 
choices. 

•  T/F, Question Graphic: This is a true/false question and a graphic included with the question text but not in the 
answer choices. 

•  Y/N, No Graphics: This is a yes/no question and no graphics included in the question text or the answer 
choices. 

•  Y/N, Question Graphic: This is a yes/no question and a graphic included with the question text but not in the 
answer choices. 

 
Question templates with graphics include the pixel size of the graphic area. This way you can size your image 
accordingly so it is not skewed upon display. 

Questions with Graphics  
The most important thing you can know about using images inside of CPS questions is that when you associate an 
image to a question, the CPS software makes a note of the directory path where the image file is located so it can 
find and display that image each time. If you move a CPS database file that has lessons of questions with images in it 
or you move the image files, those image files will not appear. 
 
It is a very good idea to always keep your CPS database file (a file with the extension .cps) and any image files 
associated to questions in that database in one folder on your hard drive. A folder with a CPS database file and image 
files in it might look like this: 
 

 
Folder with CPS Database and Image Files 
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! NOTE: The Taas 4 folder in the left part of the window is where the taas4.cps database file and the 

associated image files are saved. 
 
Now if you move the image files or the CPS database file, you can move the entire folder and make certain that 
images will appear when you engage and deliver lessons. 
 

Show Graphic After Response 
The Show Graphic After Response option is only available with question templates that include a question graphic. 
If you select a question template that allows graphics in the 
question stem, and you want that image to appear WITH the 
question during the response cycle, then click the Options menu 
item and make sure there is NOT a checkmark beside that 
command.  
 
If you do not want the image to appear with the question during the response cycle, but rather for that image to show 
AFTER you have ended the response cycle, then make sure there IS a checkmark beside the Show Graphic After 
Response command. This is ideal in case the image would ‘give away’ the answer. 
 
It is important to know that if you have this option turned ON for one question (so that the graphic will be displayed 
AFTER you have ended the response cycle), this option will automatically stay ON until you turn it off. 
 
 

Show Graphic Full Screen 
The Show Graphic Full Screen option is only available with question templates that include a question graphic. If 
you select a question template that allows graphics in the 
question stem, and you want that image to appear in the entire 
space of the CPS window, then click the Options menu item and 
make sure there is a checkmark beside that command.  
 
You might use this option if the image is the question itself: an artist’s work, math or science equations, etc. 
 
If you would rather that the image appear the size in which it is formatted when you added it to the question (see the 
pixel count for each graphic area in a question template), then make certain that this option is OFF. 
 
It is important to know that if you have this option turned ON for one question (so that the graphic is displayed full 
screen), this option will automatically stay ON until you turn it off. 
 
 

Adding Graphics to Questions 
The graphics you add to questions can in .jpg, .gif or .bmp format. The smaller the file size the better though, and 
usually .jpg is the smallest, followed by .gif and then .bmp file types can be the largest. 
 
We recommend that you copy any image files that you want to include in a CPS question to the same directory where 
that database is, and then be certain NOT to move those image files. Questions with graphics look for that image file 
in the directory where it was added from, so if you move it, the image will not be found and therefore will not 
appear.  
 
Another key feature is that the question templates with graphics include the pixel size of the graphic area. This way 
you can size your image accordingly so it is not skewed upon display. 
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There are several ways you can include an image into a question, but before you do make certain your image files are 
all together in the same directory as your open database: 
 
Method 1 
1. After you have selected a question template with graphics, left click inside the graphic area and a dialog box 

called Set Image Files opens. 
2. Use the Look in drop down list at the top of the dialog box to browse to the directory where you saved your 

image files. 
3. Highlight an image file that you want to display in this graphic area. 
4. Click the Open button. 
5. That image appears in the graphic area of the question or answer options. 
6. Click the File menu item and the Save command, or click the Save and Move to Next Question icon from the 

Question Author toolbar. 
 
 
Method 2 
1. After you have selected a question template with graphics, right click inside the graphic area and a pop up menu 

appears. 
2. Click the Browse command. 
3. A dialog box called Set Image Files opens. 
4. Use the Look in drop down list at the top of the dialog box to browse to the directory where you saved your 

image files. 
5. Highlight an image file that you want to display in this graphic area. 
6. Click the Open button. 
7. That image appears in the graphic area of the question or answer options. 
8. Click the File menu item and the Save command, or click the Save and Move to Next Question icon from the 

Question Author toolbar. 
 
 
Method 3 
This requires that you have your CPS software open to a question template and your Windows Explorer window 
open simultaneously. You can move the CPS window around the screen and adjust the size of your Windows 
Explorer window so that you can see both at the same time.  
 
If you need to, use the toggle function of ALT+TAB to go back and forth between the CPS and Windows Explorer 
windows easily and quickly. 
 
1. Start the CPS software and add a question to a lesson.  
2. When a question template with graphics is open, start your Windows Explorer. 
3. Resize and move your windows so you can see both windows simultaneously. 
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Windows Explorer and CPS Question Template with Graphic Open Simultaneously 
 
4. In your Windows Explorer, browse to the directory where your open CPS database and image files are saved.  
5. Highlight the image file you want include in the question. 
6. With your left mouse button depressed, drag that image from the Windows Explorer window to the graphic area 

of the question template. Do NOT release your mouse until the image file is OVER the graphic area.  
7. The image will appear in that graphic area. 
8. Click the File menu item and the Save command, or click the Save and Move to Next Question icon from the 

Question Author toolbar. 

Deleting Graphics from Questions 
If you have questions with graphics that you want to delete from the question, use these steps: 
1. Start CPS as described in previous sections. 
2. Open the database that has the lesson with the question and graphic you want to delete. 
3. Click the Lesson tab. 
4. Select the lesson from the list. 
5. Click the Edit button. The Lesson Name window opens. This window displays all of the questions currently in 

this lesson. 
6. Select the question with graphic you want to delete from the list. 
7. Click the Edit button. This opens the Question Authoring window. 
 
! NOTE:  The file path of an image included in a question can be displayed by rolling your mouse cursor 
over the image itself or right-clicking on the image.  
 
8. Right-click on the graphic area. A pop up menu appears. 
9. Click the Remove command. 
10. The image is deleted. 
11. To add a new image to this question, follow the instructions in Adding Graphics to Questions. 
12. Click the File menu item and the Save command, or click the Save and Move to Next Question icon from the 

Question Author toolbar. 
 

Question and Answer Choices (If Applicable) 
In the Question Authoring window there are very clearly defined text boxes in which to type text for the question 
and for the answer choices. To add a graphic to a question or answer choice, right-click in the area where the graphic 
will go (the large blank area onscreen when applicable) and select the file from its location on your system 

Subjective Questions 
During the Question Authoring (see Add Questions to Lessons) you can make any question subjective (does not 
have a correct or incorrect answer selected) by not having a checkmark beside any answer option. A subjective 
question would look like this: 

 
Question Author Window for a Subjective Question 
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Notice that there is NOT a chcckmark beside any one answer option to indicate a correct 

resposne. 
Difficulty Level  
Questions can range in difficulty from 1 (easiest) to 5 (hardest). Use the Difficulty drop-down list to select 1-5.  
 

Format (Font Style) 
Once you start creating questions, the default font (that you can select from the Settings menu item on the Tab 
window) can be adjusted on the Question Authoring window. You can alter the font style by using the Format menu 
item: 

 
 

a. Highlight question and/or answer text in the question author window. 
b. Click the Format menu item 
c. Click the Font, Color, Subscript or Superscript command  
d. In the dialog box that opens, adjust that property to your discretion. 

 
Changes to the font style will be attributed to highlighted text only. 
 
! NOTE: If you use the Superscript or Subscript option and then decide to ‘undo’ that special format, be 

aware that you will have to retype that text in order to get it to a normal line format. 

Character Map 
Also included in the CPS question authoring window is the ability to add specialized characters to your questions or 
answers. This is helpful for math and science teachers, as they require certain symbols to accurately express 
equations and other course relevant data. But any one can use the character map to incorporate a more specialized 
question into any lesson. Here’s how: 
 
1. Simply place your cursor in the question or answer text box where you want a special character to be placed. 
2. Click the Tool menu item and then the Character Map command. 
 

 
 
3. The character map window opens. 
 

 
Character Map Window 

 
The special font show by default each time you open the character map is SYMBOL.  
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4. You can adjust this font style if you like by using the arrow in that drop-down list to see other character map 

options. 
5. Find the character in the large portion of the window you want to incorporate into your questions or answers. 
6. Click the Select button. 
7. That character will appear in the Characters to Copy text box. 
8. Repeat steps 5-7 for as many characters as you want to add. 
9. Click the Copy button. 
10. Click the Close button and return to the Question Author window. 
11. Make sure your mouse cursor is where you want the characters to be placed. 
12. Use the keyboard command CTRL+V to Paste the characters into this area. 
 
These special characters will be displayed during an engage session just like any other text. 

Create Note 
Often times, questions have an answer, and then they also have an explanation. Or at least deserve some background 
information. That is why we let you create notes to accompany questions. For example, while authoring a question 
about Indefinite Pronouns, you can add a note that defines Indefinite Pronouns and compares that to the definition of 
Personal Pronouns. 
 

a. From the Question Authoring window, click the Question menu item. 
b. Click the Create Note command.  
c. The Note Author window opens.  
d. Type in your note, then use the buttons at the top of the window to adjust the format: 

•  Font: adjust the size and style of the text in your note. 
•  Color: make all of the text in your note, or only selected words in your note, colored to draw 

attention to it. 
 

 
Note Author Window 

 
 

e. When you have finished typing and formatting your note, click the Save button. Or click Close to negate 
any note you may have just added. 

f. Back on the Question Authoring window, be sure to click the Question menu item and the Save command 
in order to associate this note with this question. 

 
Any note you associate with a question will be available during session delivery after you have clicked the End 
button. 
 

Associate Objectives to Question 
After you have typed in a question and answer options, associate specific learning objectives to this question using 
these steps: 

a. Click the Question menu item 
b. Click the Save command. 
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c. Then click the Question menu item again. 
d. Next click the Associate Objectives command. 
e. A list of objectives in the database opens. 
f. Click inside the boxes beside as many objectives as you associated with this question. Use the + icons to see 

any sub-objectives and select those too if you like. 
g. Click the OK or Cancel button. 

 
To review which objectives are associated with any question, open a question in the question author window and 
repeat steps c and d. 
 
Add Questions to Lessons (cont.’d) 
 
10. Once you are satisfied with the question you have added to the lesson, use the question author toolbar to: 
 

 
Question Author Toolbar 

 
Roll your mouse over each icon from left to right on the toolbar to see their function: 
•  Click Save: stays on the Question Authoring page 
•  Click Move to Previous Question: move to the previous question in the lesson 
•  Click Move to Next Question: move to the next question in the lesson 
•  Click New Question: negate any text or images you may have just added and ‘redo’ this question number 
•  Click Objectives: displays objectives in this database that can be associated to questions; see Associate 

Objectives to Question for instructions. 
•  Click Save and Move Previous: this command saves any change you have made and then moves you to the 

previous question in the list 
•  Click Save and Move Next: this command saves any change you have made and then moves you to the 

next question in the list. If the question you are saving is last in the list, clicking Save and Move Next will 
open a new lesson template 

 
11. Repeat steps 7-10 for as many questions as you want to add to the lesson. 
12. When you have added as many questions as you want to, click File then Close. 
13. All questions are listed on the Lesson Name window. 
14. Click the Close button on the Lesson Name window when you are satisfied with all number of questions you 

have added to the lesson. 
 
If you discover later that you want to add more questions to a lesson or edit existing questions in a lesson, then use 
the instructions in Edit an Existing Lesson. 
 
Lesson Builder 
Using the Lesson Builder function, you can build one lesson of questions from several pre-existing lessons and 
databases of questions. For example, if a Language Arts database has 32 lessons in it (each lesson representing a 
chapter from a text), you can create a mid-term exam from the first 6 lessons (chapters) without re-typing all the 
questions. Or you can create a lesson from multiple databases.  
 
Lesson Builder Window 
•  The top pane is the current lesson (the one that you are creating or editing). 
•  The bottom left pane is a list of the lessons available in the database shown 

directly above it. 
•  The Browse button allows you to select a database (.cps file) from which 

to take questions. 
•  The bottom right pane is a list of the questions available in the lesson 

selected in the bottom left pane. 
•  The Close button at the bottom of the screen will close the builder window. 



CPS Instructional Guide  15 

Building Lessons 
1. Start CPS. 
2. Open the database you want to create a new lesson in (see Opening an Existing Database for instructions). 
3. Click the Lessons tab. 
4. Click the New button to create a new lesson (follow the instructions in Create a New Lesson if necessary). 
5. When the shell of the new lesson has been created and the lesson name appears in the list, highlight that lesson 

name. 
6. Click the Edit button. 
7. When the Lesson Name window opens, click the Builder button. 
8. The Lesson Builder window opens. 
 
! NOTE: Check that the database that is open in the bottom left pane is what you want to take questions 
from. If this is not the correct database, use the Browse button to find and open the database from which you want to 
select questions. 
 
9. Select a lesson from the database open in the bottom left pane. 
10. The questions for that lesson will be displayed in the bottom right pane. 
11. In the bottom right pane, select questions that are to be copied into the new lesson: 
 
Question selection: 
•  Use the Ctrl key, or the Shift key, and your mouse to select specific questions to be included in the new lesson. 

With your mouse button depressed, drag those selected questions into the top pane. 
•  Click the Select Random Question button to choose the number of specific question types you want to include 

in the new lesson. Click the OK button to complete this random 
selection. 

 
 

Random Question Selector in the Lesson Builder 
 
12. Repeat step 11 for as many questions as you want to add to the new 

lesson, or go back to step 9 if you want to incorporate questions from a 
different database into the lesson. 

13. When you have completed ‘building’ a new lesson from an existing 
database(s), click the Close button. 

14. The Lesson Name window appears and displays the questions selected 
in step 11. 

15. Click Close from the Lesson Name window to return to the Lessons tab. 
 
Import Existing Lessons 
CPS also lets you import pre-existing lessons from other CPS databases or lesson databases created by another 
eInstruction product, HyperVision. This import function is a real time-saver for busy instructors. For example, if you 
have a lesson in a database for a marketing class that would be beneficial for your management class to review than 
you can import the marketing lesson to the management database. This is how you do it: 
 
1. Start CPS. 
2. Make sure that you have open the database into which you want to import a .cps or .mdb lesson. 
3. Click the Lesson tabs. 
4. Click the Import button. A new dialog box opens. 
5. Click the Browse button and look for that path and file name of the database that has the lesson you want to 

import. 
6. Next select that file and click the Open button. 
7. The path and file name are displayed in the dialog box.  
8. Any lessons in the database are displayed in the larger text area of the dialog box. 
9. Select individual lessons from this database by clicking in the box beside each lesson name. Or you can choose 

to import all of the lessons from this database by clicking inside the Select All option. 
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10. Click the OK button when all desired lessons are selected. 
Depending on the lesson sizes and the speed of your processor, 
this import may take some time. 

11. The imported lessons are now listed on the Lessons tab. 
12. You can go about editing lessons, questions and delivering 

lessons with these imported lessons as you would any that you 
authored with CPS. 

 
 

 
Import Lessons Dialog Box 

 
! NOTE: When you import a lesson from one database into another, any rosters in the first database will not 

be imported into the new database. You can do this separately using the Import command from the Roster tab. 
 
Edit Lessons 
You can edit an existing lesson by: 
 
•  Adding questions to an existing lesson 
•  Copying questions 
•  Editing questions in the lesson  
•  Editing the lesson attributes 
•  Deleting questions from the lesson 
 
Add Questions to an Existing Lesson 
1. Start CPS as described in previous sections. 
2. Open the database that has the lesson you want to edit. 
3. Click the Lesson tab. 
4. Select the lesson from the list. 
5. Click the Edit button. The Lesson Name window opens. This window displays all of the questions currently in 

this lesson. 
6. To add a new question, click New and follow the instructions from Add Questions to Lessons. 
7. Once you are satisfied with the question you have added to the lesson, use the question author toolbar to: 
 

 
Question Author Toolbar 

 
Roll your mouse over each icon from left to right on the toolbar to see their function: 
•  Click Save: stays on the Question Authoring page 
•  Click Move to Previous Question: move to the previous question in the lesson 
•  Click Move to Next Question: move to the next question in the lesson 
•  Click New Question: negate any text or images you may have just added and ‘redo’ this question number 
•  Click Objectives: displays objectives in this database that can be associated to questions; see Associate 

Objectives to Question for instructions. 
•  Click Save and Move Previous: this command saves any change you have made and then moves you to the 

previous question in the list 
•  Click Save and Move Next: this command saves any change you have made and then moves you to the 

next question in the list. If the question you are saving is last in the list, clicking Save and Move Next will 
open a new lesson template 

 
8. Repeats steps 6 and 7 for as many questions as you want to add to this lesson. 
9. When you have added as many questions as you want to, click File then Close. 
10. Repeat steps 4-7 for as many lessons as you want to add questions to. 
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Copying Questions 
You can create a question and then duplicate that question within the same lesson, editing portions of the question of 
make it different than the original. For example, you may want a ‘question/answer template’ where the answers to 
every question are the same but the question changes, like ‘Do you agree with …’ statements, where all answer 
options would be: 
•  Agree  
•  Moderately agree  
•  Unsure  
•  Disagree moderately  
•  Disagree  
 
1. Start CPS as described in previous sections. 
2. Open the database that has the lesson you want to edit. 
3. Click the Lesson tab. 
4. Select the lesson from the list. 
5. Click the Edit button. The Lesson Name window opens. This window displays all of the questions currently in 

this lesson. 
6. Select a question or a group of questions from the Lesson window. 
7. Click the Copy button. 
8. The selected questions are copied and then displayed at the end of the lesson.  
9. To edit a duplicated question, select that question and click the Edit button. See Edit Questions in an Existing 

Lesson for more instructions. 
10. Once you are satisfied with the question you have added to the lesson, use the question author toolbar to: 
 

 
Question Author Toolbar 

 
Roll your mouse over each icon from left to right on the toolbar to see their function: 
•  Click Save: stays on the Question Authoring page 
•  Click Move to Previous Question: move to the previous question in the lesson 
•  Click Move to Next Question: move to the next question in the lesson 
•  Click New Question: negate any text or images you may have just added and ‘redo’ this question number 
•  Click Objectives: displays objectives in this database that can be associated to questions; see Associate 

Objectives to Question for instructions. 
•  Click Save and Move Previous: this command saves any change you have made and then moves you to the 

previous question in the list 
•  Click Save and Move Next: this command saves any change you have made and then moves you to the 

next question in the list. If the question you are saving is last in the list, clicking Save and Move Next will 
open a new lesson template 

 
11. When you have added as many questions as you want to, click File then Close. 
12. Return to the Lesson tab by clicking Close. 
 
Edit Questions in an Existing Lesson 
1. Start CPS as described in previous sections. 
2. Open the database that has the lesson you want to edit. 
3. Click the Lesson tab. 
4. Select the lesson from the list. 
5. Click the Edit button. The Lesson Name window opens. This window displays all of the questions currently in 

this lesson. 
6. To add a new question, click New and follow the instructions from Add Questions to Lessons. 
7. To edit an existing question, select that question from the list. 
8. Click the Edit button. This opens the Question Authoring window. 
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9. Make any changes to the question, answer choices, question template, subjective status, difficulty level, format, 
note and objectives from this window. 

 
! NOTE:  The file path of an image included in a question can be displayed by rolling your mouse cursor 
over the image itself or right-clicking on the image.  
 
10. When you are satisfied with the question you have added to the lesson, use 

the question author toolbar to: 
Roll your mouse over each icon from left to right on the toolbar to see their function: 
•  Click Save: stays on the Question Authoring page 
•  Click Move to Previous Question: move to the previous question in the lesson 
•  Click Move to Next Question: move to the next question in the lesson 
•  Click New Question: negate any text or images you may have just added and ‘redo’ this question number 
•  Click Objectives: displays objectives in this database that can be associated to questions; see Associate 

Objectives to Question for instructions. 
•  Click Save and Move Previous: this command saves any change you have made and then moves you to the 

previous question in the list 
•  Click Save and Move Next: this command saves any change you have made and then moves you to the 

next question in the list. If the question you are saving is last in the list, clicking Save and Move Next will 
open a new lesson template 

 
11. When you have added as many questions as you want to, click File then Close. 
12. Repeat steps 7-10 for as many questions as you want to edit. 
 
Lesson Attributes 
1. Start CPS as described in previous sections. 
2. Open the database that has the lesson you want to edit. 
3. Click the Lesson tab. 
4. Select the lesson from the list. 
5. Click the Edit button. 
6. In the Lesson window, click the Lesson Attr … button in the top right corner. 
7. In the Lesson Attribute window you can edit the lesson name or the lesson description. 
8. Click OK to save your changes. Click Cancel to negate your changes. 
9. Click the Close button on the bottom of the Lesson Name window to return to the Tabs window. 
 
Delete Questions from a Lesson 
1. Start CPS as described in previous sections. 
2. Open the database that has the lesson you want to delete questions from. 
3. Click the Lesson tab. 
4. Select the lesson from the list. 
5. Click the Edit button. 
6. In the Lesson window, select the question you want to delete. 
7. Click the Delete button. 
8. A confirmation appears onscreen before you delete the question. Click OK to continue or Cancel. 
9. The list of questions automatically updates itself. 
10. Repeats steps 6-8 for as many questions as you want to delete from this lesson. 
 
Print Lessons for Exams 
Sometimes, it is more effective to deliver exams to students in a hard copy format and then record performance data 
after the fact, than to deliver exams in real-time mode. Unlike quizzes, which work well for students in the real-time 
format, exams can be delivered with higher security in mind.  
 
CPS lets you use a hard copy test created inside CPS or an existing hard copy test. If you use an existing hard copy 
test, CPS allows you to create an online answer key for that test, so you can at the very least get online performance. 
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If you use an existing hard copy test, CPS allows you to create an online answer key for that test, so you can at the 
very least get online performance feedback from students and generate reports. 
 
Print a Test from a CPS Lesson  
1. Start CPS. 
2. Open the database that has the lesson you want to print. 
3. Click the Lesson tab. 
4. Select the lesson you want to print. 
5. Click the Print button. This launches the CPS Print Lesson window. 
6. Every question selected in step 4 is displayed in the new window. 
7. Use your mouse to click beside the questions you want to print out, or click the Select All option box to include 

every lesson question on the print out. 
8. Optionally, you can include a lesson key with the print out.  
9. Click the Preview button. The contents of the print out, just as they will appear, are displayed in the Reporting 

Preview window. 
! NOTE: The directory path of any image associated with a question will be displayed in the Preview 
window. 
10. Click the Export/Print button from the Reporting Preview window if you are satisfied with the data. 
11. The print out contents are automatically opened in a word processing application and automatically saved to the 

CPS folder on your hard drive. Look at the word processing application’s window title bar to see the file name 
of the print out. 

! NOTE: If Microsoft Word is set to automatically view text and image files, then images associated with 
questions will display as well as the text. 
12. Review the file and make any layout adjustments. 
13. Click the File menu item. 
14. Click the Print command. 
15. Make sure you are connected to a printer, then click the OK button to print this lesson. 
16. You can close the word processing application and the lesson you printed in step 15 at any time. 
17. Return to the Reporting Preview window and click Close. 
18. Back at the CPS Print Lesson window, click the Close button to return to the Lesson tab. 
 
FastGrade Answer Key for Existing Hard Copy Tests 
It is a good idea to have your existing hard copy test with you when you create a CPS FastGrade answer key for it. 
1. Start CPS. 
2. Open the database that has the lesson you want to print. 
3. Click the Lesson tab. 
4. Click the FastGrade button. The FastGrade window opens. Below is an explanation of this window’s 

components: 
Title:  Type in a test name or a descriptive name for your use later. 
Description: Type a description of the FastGrade answer key you are creating (optional). 
Number of Questions tally: This tally displays the number of questions you have successfully added to the 

FastGrade answer key. 
Question tally: This tally displays the question number you are currently working on. This number will always be 

1 ahead of the Number of Questions tally. 
Question type columns: Each question type (in its broadest format) is represented in individual columns. 

This enables you to add various question types into the FastGrade answer key. 
Previous: Use this button to move to the previous question in your FastGrade answer key. This action will 

highlight the previous question’s question type and correct answer as well as displaying the 
number of this question in the list of questions. 

Next:  Use this button to move to the next question in your FastGrade answer key. This action will 
highlight the next question’s question type and correct answer as well as displaying the number of 
this question in the list of questions. 

OK: Click OK when you are finished adding questions to your FastGrade answer key. This action takes 
you to the Lesson tab. 

Cancel:  Click Cancel to negate any data you have entered and return to the Lesson tab. 
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CPS FastGrade Window 
5. Type in a lesson title and optional description. 
6. Then use your mouse to click on the correct answer and 

question type of the first question on your hard copy test. 
Notice the correct answer button you clicked changes color to 
indicate it has been selected. 

7. The Number of Questions tally and the Question tally increase 
by one. 

8. Repeat steps 6 and 7 for every question of your hard copy test. 
9. Click OK when you have entered a correct answer and 

question type for every question on your hard copy test. This 
action returns you to the Lesson tab. 

10. The lesson name you entered in step 5 is displayed on the Lesson tab.  
 
How Print Exams and CPS Work Together  
Whether you have printed a test from a CPS lesson and given it out for students to answer by hand, or you have had 
them take an existing hard copy test then made a FastGrade answer key for it, you can grade those hard copy tests 
and gather performance data by doing this: 
1. After students have completed the exam, pass out their response pads (remember, their name in the roster should 

coincide with the response pad number they use).  
2. Then, deliver the lesson that represents that exam (either with the questions listed in it or a FastGrade answer 

key) using the Engage button on the Lesson tab. 
3. You control the pace of questions as every student ‘records’ their answer to each question. You will know when 

to go onto the next question by the counter box. 
4. When the students have ‘recorded’ their exam answers using the real-time Exam session type, collect the paper 

exams and response pads. 
5. Now you have a recorded session on the Reports tab of the students’ responses to the exam questions.  
 
Delete a Lesson 
You can delete an entire lesson of questions by following these steps: 
1. Start CPS as described in previous sections. 
2. Open the database that has the lesson you want to delete questions from. 
3. Click the Lesson tab. 
4. Select the lesson from the list that you want to delete. 
5. Click the Delete button. 
6. A confirmation message appears. Click the OK or Cancel button. 
7. The list of lessons on this Lesson tab renumbers itself.  
8. Repeats steps 4-6 for as many lessons as you want to delete. 
 
Deliver Lessons Without Recording Performance Data (Preview Button) 
A lesson of questions can be delivered in a session without recording performance data. This is a useful tool to quiz 
students on class material and prepare for tests. For information and instructions about lesson delivery please see 
CPS Session without Recorded Performance Data.  
 
Deliver Lessons to Record Performance Data (Engage Button) 
Lessons can be delivered to students in a mode that requires their feedback via the CPS response system. This 
feedback, or performance data, is saved in the open database and can be accessed later for evaluation. For 
information and instructions about lesson delivery please see CPS Session with Recorded Performance Data. 
 
Quit CPS 
Click the File menu item then the Exit command to quit CPS from anywhere in the program.  
 


